
Data Mining with the 
PDF-4 Databases 

FeO Non-stoichiometric Oxides 



This is one of three example-based tutorials for using the 
data mining capabilities of the PDF-4+ database and it 
covers the following topic: 

• FeO Non-stoichiometric Oxides 

– sorting out temperature and stoichiometric effects on cell 
parameters 

Two other similar tutorials for data mining exist and cover 
the following topics: 

• CIGS Photovoltaics   (Solid Solution Example) 

– solid solution / cell parameter relationship 

• Carbamazepine  (Resolving Pharmaceutical Polymorphs) 

– a PDF-4/Organics application  

– investigating polymorphic forms of an active pharmaceutical 
ingredient (API) 



Stoichiometric Factors Affecting the 
Diffraction Pattern of FeO 

• FeO is frequently non-stoichiometric with 
Fe-site vacancies. 

• These defects have crystallographic effects 
and can cause shifts in the observed powder 
diffraction peaks. 

• Summaries of this effect can be “mined” 
from the PDF-4+ database and displayed for 
further study. 



Crystal Structure of FeO* 

Cubic System 

Space Group: Fm-3m 

NaCl type structure 

*Structure taken from PDF entry 04-004-7638 calculated from the Linus Pauling File database (MPDS). 



Data Mining for FeO Entries:  Step 1  
Use the Preferences Window to establish what will be displayed in the 
Search Results table  .  .  . 

1. Click the ‘Preferences’ icon 1. Click the ‘Preferences’ icon 

2. Click the ‘Search’ tab in the 

‘Preferences’ window 



Selecting Fields for the Results Table 

Expandable 

folders contain 

individual fields 



Selecting Fields for the Results Table 

Available Fields: 

Use these buttons to move selected items between the 

‘Available Fields’ list of 90 items and the ‘Selected Fields’ 

list of items that will be displayed in the results table. 



Selecting Fields for the Results Table 

Selected Fields: 

Use these buttons 

to move a selected 

item up or down in 

the listed order for 

the results table. 

Available Fields: 

Use these buttons to move selected items between the 

‘Available Fields’ list of 90 items and the ‘Selected Fields’ 

list of items that will be displayed in the results table. 



Selecting Fields for Results Table (FeO) 

Setting up the fields as shown 

here will serve the purposes of 

this example.  (Click ‘OK’ at the 

bottom of the ‘Preferences’ 

screen when finished.) 

-   Always selected 

-   Subfiles/Database Filters 

-   Subfiles/Database Filters 

            Elements 

-   Elements 

-   Structures 

-   Structures 

-   Structures 

-   Structures 

-   Miscellaneous 

Available Fields folder 



Chemistry Criterion for Search:  Fe and O only entered 
on ‘Periodic Table’ tab of ‘Search’ window 

The Boolean method 

can be used to enter 

this criterion. 

Search Window Icon 



Chemistry Criterion for Search:  Fe and O only entered 
on ‘Periodic Table’ tab of ‘Search’ window 

First click elements Fe and O . . . 



Chemistry Criterion for Search:  Fe and O only entered 
on ‘Periodic Table’ tab of ‘Search’ window 

Then click ‘Only’ . . .  



Chemistry Criterion for Search:  Fe and O only entered 
on ‘Periodic Table’ tab of ‘Search’ window 

Finally click ‘Add’ to include 

this criterion for the search. 



Chemistry Criterion for Search:  Fe and O only entered 
on ‘Periodic Table’ tab of ‘Search’ window 

Once entered, the chemistry 

criterion can be verified here. 

Periodic Table tab text turns red to indicate 

criteria have been entered on this tab. 



Structure Criterion for Search:  FCC Space Group #225 – ‘Fm-3m’ 
entered on ‘Structures’ tab of ‘Search’ window 



Structure Criterion for Search:  FCC Space Group #225 – ‘Fm-3m’ 
entered on ‘Structures’ tab of ‘Search’ window 

Perform search using the 

specified chemistry and 

space group criteria. 



Results of PDF-4+ Search for FeO 

A total of 60 entries for Fe1-xO 

compounds 

 

You will get 66 entries if the 

‘Include Deleted Patterns’ box 

is checked on the ‘Subfiles/ 

Database Filters’ tab of the 

Search window. 

A description of your search 

criteria is shown here. 



Analysis of the Resulting Database Entries 

Most fields in the results 

table can be graphically 

illustrated in either X-Y plot 

or histogram form. 

For the current application, 

we will use an X-Y plot to 

illustrate the a-axis cell 

parameter as a function of 

atomic % Fe. 

To do this, ‘Graph Fields…’ is 

first selected from the 

‘Results’ drop down menu of 

the ‘Results’ window. 



The ‘Graph Fields’ Selection Box  

Here the types of data to plot on the x- and y-axes of 

the graph are selected. 

To select the type of data 

for the x-axis, use the 

drop-down menu here. 



The ‘Graph Fields’ Selection Box  

Here the types of data to plot on the x- and y-axes of 

the graph are selected. 

For this graph, we will 

choose ‘Atomic %’ for 

the X-axis.   



The ‘Graph Fields’ Selection Box  

Here the types of data to plot on the x- and y-axes of 

the graph are selected. 

Now we select the 

element whose atomic % 

is to be plotted – in this 

case, ‘Fe’. 



The ‘Graph Fields’ Selection Box  

Here the types of data to plot on the x- and y-axes of 

the graph are selected. 

Next we select the data 

to be plotted along the y-

axis, namely ‘XtlCell a’.  



The ‘Graph Fields’ Selection Box  

Here the types of data to plot on the x- and y-axes of 

the graph are selected. 

Click on ‘Create Graph’ 

to display the graph. 



FeO  a-axis Cell Parameter vs. Atomic % Fe 

This graph shows little apparent correlation between atomic % Fe and a-axis.   

Note that entries reported as being stoichiometric (1:1) are in a vertical line at 

right (50 at.% Fe). All others report less than stoichiometric amounts of Fe. 

Stoichiometric – 1:1 



FeO  a-axis Cell Parameter vs. Atomic % Fe 

Ambient 

High Temperature 

Further examination of individual entries separates ambient, high-temperature, 

and high-pressure determinations of the a-axis. 

High Pressure 



FeO  a-axis Cell Parameter vs. Atomic % Fe 

Ambient 

High Temperature 

• Individual entries from this chart may be examined by left-clicking on individual 

spots. The illustration above shows the point label that appears when the 

mouse cursor is ‘hovered’ over this data point.   

High Pressure 



FeO  a-axis Cell Parameter vs. Atomic % Fe 

Ambient 

High Temperature 

• If you left-click at this point, depending on the proximity of nearby points on the 

graph, you may directly bring up the 01-074-1883 entry, or bring up a list of the 

nearby points as shown above.  In the latter case, the point of interest is selected 

from the list and then ‘OK’ is clicked.  This entry is shown on the next slide. 

High Pressure 



PDF Card for FeO (01-074-1883) 

Fe.932O 

The ‘PDF’ tab of this window displays 

the actual formula and stoichiometry. 



PDF Card for FeO (01-074-1883) 

The ‘References’ tab of this window shows the source of the 

information. Authors, in this case, are E. R. Jette and F. Foote. 



PDF Card for FeO (01-074-1883) 

This window may be closed to return to the 

previous graphical plot of ‘a’ vs. atomic % Fe. 



FeO  a-axis Cell Parameter vs. Atomic % Fe 

Ambient 

High Temperature 

High Pressure 

Examining another nearby point, corresponding to entry 01-074-1882, we note that 

the reference lists the same authors, E. R. Jette and F. Foote. 

 

There may be other entries across the range of stoichiometries that are based on 

these authors’ work.  We can add an author’s name to the search criteria to 

examine just their entries. 



Adding an Author to the Search 

Without resetting the previous search criteria, we can add an author to the previous 

Periodic Table (Only Fe and O) and Structure (Space Group 225) specifications.  Adding 

‘Jette’ to the ‘Author’ box, and clicking ‘Search’ gives the Results list on the next slide: 



Search Result Including ‘Jette’ as Author 

These results can be graphed as before . . . 

These represent the results of one systematic study of stoichiometry 

vs. structure published by Jette & Foote in J. Chem. Phys. 



The underlying numerical values from this resulting graph can be 

exported for analysis by other software programs such as Microsoft® 

Excel®.  From the ‘File’ menu on this graph, ‘Save…’ is selected. 



The values can be saved to a ‘CSV’ (comma separated values) file 

for import into many other software analysis programs.  The file 

name and folder are specified here as well. 



An example of a Microsoft® Excel® analysis of the Jette & Foote data.  

The linear analysis equation can be rearranged to give . . .  

 

                 At. % Fe  =  45.05 * a-axis (Å)  - 145.6 

 

This would allow one to calculate the atomic % Fe from a measured a-

axis value.   



FeO  a-axis Cell Parameter vs. Atomic % Fe 

Ambient 

High Temperature 

Several entries in the ‘High Temperature’ region of the original results graph 

come from a single study, “Point Defect Clusters in Wuestite” by Radler, Cohen, 

& Faber, J. Phys. Chem. Solids, 51, 217 (1990).  We can again use the author 

criterion to look at just these entries. 

High Pressure 



Change Author for Search 

On the ‘References’ tab, ‘Cohen’ has been entered in the ‘Author’ field to obtain the 

desired PDF entries. The ‘Structures’ and ‘Periodic Table’ tabs contain the previously 

entered information regarding FeO and space group 225. This search will yield the 10 

entries found on the next slide. 



PDF Entries from Radler, Cohen, & Faber Study (1990) 

The a-axis cell parameter for just these resulting 10 

entries can now be plotted vs. atomic % Fe and the 

resulting graph is shown on the following slide. 



Graph of Radler, Cohen, and Faber FeO Entries 

1 

2 

1.  Data varying T from 1123 to 1373 C 
with slightly increasing O content 

2.  Data varying stoichiometry at 
1323 C from Fe0.88O to Fe0.95O 

These points represent two sets of high-temperature X-ray data obtained in the 

referenced report as follows: 



Return to the original list of 63 FeO entries using ‘History’  . . . 
Use the ‘History’ icon to 

retrieve any searches 

already performed 

during this session. 

Another Look at FeO results - Density 



Return to the original list of 60 FeO entries using ‘History’  . . . 
Choose the original search:  

{Only (Fe And O)} And {International Space Group 

Number Exactly ‘225’} And {Not Status (Deleted)} 

and click the ‘Results’ button. 

Another Look at FeO results - Density 



Another Look at FeO results - Density 

Another way to analyze 

this data is to look at the 

density as a function of 

cell parameter. This is 

performed by using the 

‘Results’ drop down menu 

to access ‘Graph Fields…’ 



Another Look at FeO results - Density 

For this graph, we will plot 

the calculated density as a 

function of the cubic cell 

parameter. 



    Results: density vs. a-axis cell 
parameter for reported FeO structures 



Entries with 1:1 atomic ratio reported for FeO 
Density is inversely proportional to cubic cell parameter 

“An X-ray Study of the Wuestite (FeO) 
Solid Solutions”  - Jette & Foote   Density 
increases very slightly as cell parameter 
goes up with increasing Fe content. 

“Point Defect Clusters in Wuestite” -  Radler, Cohen, & Faber  Density decreases 
as a-axis increases (inverse relationship) as T is varied from 1123 to 1373 C with 
slightly increasing O content.  Both density and a-axis increase dramatically as 
stoichiometry at 1323 C is increased from Fe0.88O to Fe0.95O. 

 

Illustration of correllations within this graph of 
density verses cell parameter for Fe1-xO data 



Summary for Data Mining 
Non-stoichiometric Cubic FeO  

• Multiple explanations exist for unit cell parameter 
variations in non-stoichiometric FeO in the PDF 

• Systematic studies regarding stoichiometry and/or 
temperature can be “mined” from the database 

• No single relationship describes all the data, thus 
different “defect” arrangements must exist for these 
materials 

• Ability to access PDF entries directly from graphs’ 
facilitates obtaining other data and references 



International Centre for Diffraction Data

12 Campus Boulevard

Newtown Square, PA 19073

Phone: 610.325.9814

Toll Free Number in US & Canada: 866.378.0331

Fax: 610.325.9823

Thank you for viewing our tutorial.
Additional tutorials are available at the ICDD website.

www.icdd.com


